
LORDUSER MANUAL

SG-Link® -LXRS®
Wireless 2 Channel Analog Input Sensor Node



© 2014 LORD Corporation
MicroStrain® Sensing Systems

459 Hurricane Lane
Suite 102

Williston, VT 05495
United States of America

Phone: 802-862-6629
Toll Free: 800-449-3878
Fax: 802-863-4093

http://www.microstrain.com
sensing_support@LORD.com
sensing_sales@LORD.com

Copyright © 2014 LORD Corporation

IEPE-Link™, Torque-Link™, 3DM-RQ1™, StrainWizard®, DEMOD-DC®, DVRT®, DVRT-Link™, WSDA®, HS-
Link®, TC-Link®, G-Link®, V-Link®, SG-Link®, ENV-Link™, Watt-Link™, Shock-Link™, LXRS®, Node

Commander®, SensorCloud™, Live Connect™, MathEngine®, EH-Link®, 3DM®, FAS-A®, 3DM-GX1®, 3DM-
GX3®, 3DM-GX4™, 3DM-DH®, 3DM-DH3™, EmbedSense®, MicroStrain®, and Little Sensors, Big Ideas.® are

trademarksof LORD Corporation.

Document 8500-0003 Revision A

Subject to change without notice.

http://www.microstrain.com/wireless
mailto:sensing_support@LORD.com
mailto:sensing_sales@LORD.com


SG-Link® -LXRS®Wireless Sensor Node UserManual

Table of Contents

1. Wireless Sensor Network Overview 6

2. Node Overview 7

2.1 Components List 8

2.2 Interface and Indicators 8

3. System Operation Overview 10

3.1 Software Installation 11

3.2 SystemConnections 12

3.3 GatewayUSB Communication 13

3.4 Automatic Node Discovery 14

3.5 Channel Configuration 16

3.6 Data Acquisition 18

3.7 Viewing Sensor Data 20

4. Node Installation 21

4.1 Mounting Recommendations 21

4.2 Optimizing the Radio Link 22

4.2.1 Range Test 23

5. Connecting Sensors 24

5.1 Sensor Requirements 24

5.2 Wiring Recommendations 25

5.3 Sensor Power 26

5.4 Node Channels Designations 26

5.5 Terminal BlockConnections 27

5.6 Pin Descriptions 28



SG-Link® -LXRS®Wireless Sensor Node UserManual

5.7 Differential Input Channels 29

5.7.1 Differential Sensors 30

5.7.2 Measuring Small Voltages 32

5.8 Single-Ended Input Channels 33

5.8.1 0 to 3VDC VoltageMeasurements 34

5.8.2 Measuring Voltages over Three Volts 35

5.8.3 Measuring Small Currents (4 to 20mA Sensors) 36

5.9 Using the Excitation Output as a Switch 37

5.10 Thermocouples 37

5.11 On-board Temperature Sensor 38

6. Sensor Settings 39

6.1 Measurement Units 40

6.2 Conversion Values 41

6.2.1 Calculating a Linear Slope 44

6.2.2 Differential Input Gain andOffset 46

Example Gain andOffset Calculations 47

6.3 Sensor Calibration 48

6.3.1 EXAMPLE: Lab or Field Calibration 50

6.3.2 EXAMPLE: Manufacturer Calibration 54

6.3.3 EXAMPLE: Internal Shunt Calibration 56

7. Powering the Node 61

7.1 Selecting the Power Source 62

7.2 Using the Internal Node Battery 63

7.3 Charging the Node Battery 64

7.4 Connecting an External Power Supply 65



SG-Link® -LXRS®Wireless Sensor Node UserManual

8. Troubleshooting 66

8.1 Troubleshooting Guide 66

8.2 Device Status Indicators 71

8.3 Using the Node Tester Board 72

8.4 Updating Node Firmware 80

8.5 Repair and Calibration 82

8.6 Technical Support 83

9. Maintenance 84

10. Parts and Configurations 85

10.1 Standard Nodes 85

10.2 Node Accessories 86

10.3 Wireless SystemEquipment 87

10.4 Warranty Information 88

10.5 Product Ordering 89

11. Specifications 90

11.1 Physical Specifications 90

11.2 Operating Specifications 91

11.3 Power Profile 93

11.4 Radio Specifications 94

12. Safety Information 95

12.1 Battery Hazards 95

12.2 User Configurable Power Settings 96

13. References 97

13.1 Related Documents 97

13.2 Glossary 98



SG-Link® -LXRS®Wireless Sensor Node UserManual System Overview

6

1. Wireless Sensor Network Overview

The LORD MicroStrain ® Wireless Sensor Network is a high speed, scalable, sensor data
acquisition and sensor networking system.  The system consists of wireless sensor interface
nodes, a data collection gateway, and full featured user software platforms based on the LORD
MicroStrain® Lossless Extended Range Synchronized (LXRS®) data communications protocol. 
Bidirectional wireless communication between the node and gateway enables sensor data
collection and configuration from up to two kilometers away. Gateways can be connected locally to
a host computer or remotely on local and mobile networks. Some gateways also feature analog
outputs for porting sensor data directly to standalone data acquisition equipment.

The selection of available nodes allows interface with many types of sensors, including
accelerometers, strain gauges, pressure transducers, load cells, torque and vibration sensors,
magnetometers, 4 to 20mA sensors, thermocouples, RTD sensors, soil moisture and humidity
sensors, inclinometers, and orientation and displacement sensors. Some nodes come with
integrated sensing devices such as accelerometers. System sampling capabilities are IEEE
802.15.4- compliant and include lossless synchronized sampling, event and burst sampling,
streaming, and data logging. One gateway can coordinate many nodes of any type, and multiple
gateways can be managed from one computer with the Node Commander® and SensorCloud™
software platforms. Integration to customer systems can be accomplished using OEM versions of
the sensor nodes and leveraging the LORD MicroStrain® data communications protocol.

Common applications of the LORD MicroStrain®Wireless Sensor Networks are wireless strain
sensor measurement, wireless accelerometer platforms, wireless vibration monitoring, wireless
energymonitoring, wireless environmental monitoring, and wireless temperaturemonitoring.
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2. Node Overview

The SG-Link® -LXRS® wireless sensor node features two analog input channels designed to
accommodate a wide range of Wheatstone bridge and analog sensors including, strain, load cell,
torque, pressure, acceleration, vibration, magnetic field, displacement, geophones, and more.
There is one channel for single ended sensor measurement, one channel for differential sensor
measurement, and an on-board internal temperature sensor. 

SG-Link® -LXRS® inputs are 12-bit resolution with ± 0.1% full scalemeasurement accuracy. The
node can log data to internal memory, transmit real-time synchronized data, and it supports event
driven triggers with both pre- and post- event buffers.

To acquire sensor data, the SG-Link® - LXRS® is used with any LORD MicroStrain® data
gateway, such as the WSDA® -Base and WSDA® -1000, and either the Node Commander® or
SensorCloud™ software interfaces, or a user- designed program.  The Node Commander®

software is included with the gateways and allows configuration of the node.

Figure 1 - SG-Link® -LXRS®Wireless Sensor Node
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2.1 Components List

The SG-Link® - LXRS® features an internal antenna and an integrated terminal block for
attaching sensors. There are no removable parts.  For a complete list of available
configurations, accessories, additional system products and ordering information see Parts and
Configurations on page 85.

Item Description Quantity
A SG-Link® -LXRS®Wireless Sensor Node 1

-- User Manual, Quick Start Guide and Calibration Certificate 1 each

Table 1 - Components List

2.2 Interface and Indicators

The SG-Link® -LXRS® interfaces include 1) a power input jack for charging the internal
battery, or externally powering the node 2) a power on/off switch 3) a power source selector
switch and 4) a terminal block for connecting sensing devices. See Figure 2 - Interface and
Indicators.
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The indicators on the SG-Link® -LXRS® include 1) a device status indicator, 2) a battery
charging indicator 3) a battery charge complete indicator and 4) a charge source indicator. The
following table describes basic indicator behavior.  During data acquisition, the device status
indicator has other advanced behaviors (see Device Status Indicators on page 71).

Figure 2 - Interface and Indicators

Indicator Symbol Behavior Node Status

Battery charge
source indicator

OFF No power source detected

ON green Charging source detected

Battery charging
indicator

OFF Node not charging

ON bright red Node battery charging

Battery charged
indicator

OFF Node charge status unknown
ON green Battery fully charged
ON green and
battery charging
indicator ON red

Battery fault condition, reset
by unplugging power and
then plugging it back in

Device status
indicator

OFF NodeOFF
Rapid flashing Node booting up
1 second pulse
(approximate)

Node active and idle

Table 2 - Indicator Behaviors
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3. System Operation Overview

The SG-Link® - LXRS®  contains an internal, rechargeable
Lithium Polymer (Li-Po) batter y. For important precautions
see Safety Information on page 95.

To acquire sensor data, nodes are used with any LORD MicroStrain® data gateway, such as the
WSDA® -Base -10x -LXRS™ or WSDA® -1000 - LXRS™ and a software interface. 

LORD MicroStrain® has two software programs available for the Wireless Sensor Network:
SensorCloud™ and Node Commander® .  SensorCloud™ is a web- based data collection,
visualization, analysis, and remote management platform based on cloud computing technology. 
SensorCloud™ provides the most complete functionality.  The Node Commander® software
package is also fully featured and includes all functions needed for sensor configuration and data
acquisition. Node Commander® is included with all data gateways and is sufficient for the basic
operations explained in this section. 

In this section hardware and software setup is described, including an overview of the Node
Commander® software menus required to configure a sensor connected to the node and begin
data acquisition.  It is intended only as a quick start guide and is not a complete demonstration of all
system or software features and capabilities.

l For an example of sensor configuration and calibration routine, or for verification of system
functionality, see Using the Node Tester Board on page 72.

l For instructions on connecting specific sensors, see Connecting Sensors on page 24.

NOTE

Tomaximize operating time, it is recommendedthat theSG-Link® -LXRS®

internal battery be charged fully before installation.  If fully discharged, it
takes approximately 6 to 8 hours to achieve a full charge. For charging
instructions see Charging the Node Battery on page 64.
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3.1 Software Installation

To install Node Commander® on the host computer, complete the following steps:

1. Insert the CD into the host computer.

2. Follow the on-screen prompts.

NOTE

TheNode Commander® software includes hardware drivers required for use
with USB gateways. Once installed, the software will automatically detect and
configure anyUSB gateways that are plugged into the host computer.
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3.2 System Connections

To acquire sensor data the following components are needed: 1) external sensors, as
applicable 2) wireless sensor node 3) data gateway 4) local or networked host computer with
access to the data acquisition software, such as Node Commander® or SensorCloud™. The
selection of sensors, nodes, gateways, and software is application dependent, but the basic
interfaces are the same. For a connections overview refer to Figure 3 - SystemConnections.

Nodes will communicate with any gateway. Gateways with analog outputs can be connected
directly to standalone data acquisition devices for data collection, however, system
configuration will still occur through a digital communication interface.

Communication protocols between the gateway and host computer vary depending on which
model gateway is used.  For example, the WSDA® -Base -10x -LXRS™ gateway utilizes local
serial connections to the host computer, such asRS232 and USB, and interface with the Node
Commander ® software.  The WSDA ® - 1000 - LXRS ™ gateway utilizes Ethernet
communications and can be used with either Node Commander® or SensorCloud™. Users
can also write their own programs by utilizing the LORD MicroStrain® Wireless Sensors
Network Software Development Kit.

Figure 3 - System Connections
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3.3 Gateway USB Communication

For USB gateways, drivers need to be installed on the host computer.  These drivers are
included with the Node Commander® software.  After the software is installed, the USB
gatewaywill be detected automatically when the gateway is plugged in.

1. Open the Node Commander® software.

2. Make all hardware connections (see System Connections on page 12). Power is
applied to the gateway through the USB connection. Verify the gateway status
indicator is illuminated.

3. Open Node Commander®.

4. When connected, the gateway should appear in the Controller window automatically
with a communication port assignment (Figure 4 - USB GatewayCommunication). If
it is not automatically discovered, verify the port is active.

Figure 4 - USB Gateway Communication
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3.4 Automatic Node Discovery

NOTE

Automatic node discovery only works in some boot-up modes, such as the
normal boot mode. When the node is set for normal boot mode and powered
on, the device status indicator on the node will flash rapidly and then pulse in
one-second intervals thereafter. If any other indicator behavior is observed, the
node may be configured for a different mode. If the node is in another boot
mode, it can be bypassed by toggling the node ON/OFF switch rapidly three
times and then leaving it in the ON position for normal power up.

1. After establishing communication with the gateway, right-click on the gateway name
in the Controller window and select Add Node > NodeDiscovery.

Figure 5 - Adding a Node in Node Commander®

2. Turn the node ON with the ON/OFF switch. During power-up the node will transmit a
message with its operating frequencywithin a few seconds.

3. When the device status indicator on the node ends the rapid flash sequence and
begins pulsing at one- second intervals, it has completed the normal boot- up
sequence and is running in idle mode. At this point the node should be listed in the
Controller window, and scanning can be stopped by selecting the Stop button in the
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NodeDiscovery window. Additional node information can be viewed by selecting the
“+” symbol next to the node name.

Figure 6 - Node Discovery
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3.5 Channel Configuration

Node channels are configured for the sensor connected to it. The sensor settings are stored in
the node memory for that channel. Only the channels and configuration options that are
available on the type of node being used will be available in the configurationmenus.

1. To enter the configurationmenu, right-click on the node name, and select Configure >
Configure Node. The Channels tab displays channel options available for the current
node.

a. Channel Enabled: indicates the channel number, and the check box is
used to enable the channel and select it for sampling. The icon next to the
check box describes the channel type, which is intrinsic to the node being
used. In the following example: a1) analog differential channel icon, a2)
analog single ended channel icon, and a3) temperature channel icon.

b. Current channel configuration: The data output, units, input, and label
describe how the channel is currently configured.

c. Configure: Select the channel Configure button to change the channel
parameters. The channel must be enabled first by selecting its adjacent
check box.

Figure 7 - Node Channels Menu
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2. To enter the channel configuration menu, select the Configure button as shown in
Figure 7 - Node Channels Menu. The channel configuration menu options change
depending on the sensor type selected.

a. Channel Label: names the channel

b. Channel diagram: describes the channel electronics and data flow

c. Conversion Coefficients: defines the type and units of the
measurement beingmade

d. PGA Settings: These settings determine what gain is applied to the
sensor measurement and set the position of the no- load baseline
measurement for the sensor signal. It is only available for differential input
channels with gain amplifiers.

e. Calibration values: Includes the slope, offset, scale, and formula used to
convert the sensor reading to engineering units. The slope and offset can
be determined from the sensor manufacturer calibration data or through a
calibration process.

Figure 8 - Channel Setup
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3.6 Data Acquisition

NOTE

Touching connected sensors and test boards or charging the node battery
while acquiring datamay induce noise on sensitive sensor signals and is not
recommended.

When data acquisition is started, each of the four sampling modes has different menu
options and views. Some have a settings menu before data acquisition begins and may
include a data list view and/or a graph view.

The following is an example of Synchronized Sampling:

1. Right click on the node name and then Sample > Synchronized Sampling.

2. In the Synchronized Sampling window select the destination folder for the data in the
Save Location field.

3. Select Apply Network Configuration, and then select Start Sampling.

Figure 9 - Node Sampling Settings
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4. Close the Synchronized Sampling window by clicking the window X in the upper right.
The Sampled Data window is behind it. The default view is the Data Grid view. Use
the “+” symbol next to the node heading to view the data statistics.

Figure 10 - Sampling Data Grid View

5. Select Graph from the View Mode field, and then click on the node name to view a
graphical representation of the data.

6. To end sampling close the Sampled Data window by clicking the red and white X on
the window tab, and select Exit > Stop Nodes.

Figure 11 - Sampling Data Graph View
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3.7 Viewing Sensor Data

Acquired data is stored in CSV format and can be viewed with Microsoft Excel, Quattro Pro,
Open Office, or other CSV editors and spreadsheet programs.  The files can be found in the
default directory or the location specified at the beginning of sampling (as applicable).

The default directory is:C:\ProgramData\Microstrain\NodeCommander\SampledData

Use Windows® Explorer or the Node Commander® File menu to access the files.  Different
samplingmodes will output different file types, and theywill be categorized in separate folders
by samplingmode and then further categorized by date, session, and/or node serial number. 

Synchronized sampling and low duty cycle files are found in the Sampled Data folder.

Datalogging files need to be downloaded from the node before they are available for viewing
and can be accessed through dataloggingmenus aswell as the File menu. They are stored, by
default, in the Downloaded Triggers folder.

Streaming data is stored in the Streaming folder.

Figure 12 - Exploring Data
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4. Node Installation

4.1 Mounting Recommendations

The SG-Link® -LXRS® is rated for indoor use only, unless used with a ruggedized outdoor
housing.  Some housings also accommodate D cell batteries, extending the battery operating
capacity and duration of the node. For more information see Node Accessories on page 86 . 

The node has two mounting tabs with holes for fastening.  The node can be mounted in any
orientation, but it is recommended that it is mounted in a way that optimizes the wireless
communications. For more information seeOptimizing the Radio Link on page 22. 

Figure 13 - Mounting the Node
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4.2 Optimizing the Radio Link

In ideal conditions, the nodes and gateway can communicate up to two kilometers apart.  In
order to accomplish this, the node must be installed in a manner that optimizes the wireless
transmission.  The SG-Link® - LXRS® operates at a 2.4GHz transmission frequency. The
internal antenna has an omni-directional radiation pattern.  Using any other antenna with the
node will void FCC compliance.

The best method for ensuring optimal radio communication is to conduct an RF survey of the
installation site. This is easily accomplished in Node Commander® by using the range test
feature to quantify the radio signal strength (RSSI) in various scenarios. See Range Test on
page 23 for instructions on using Node Commander® for measuring RSSI. The following
bullets are general guidelines for maximizing transmission range.

l Establish Line of Sight (LOS) between the node and gateway antenna as best as
possible.  Minimize the obstructions between them such as buildings, terrain,
vegetation, or other physical barriers.  Increase the mounting height of the node if it
allows a clearer LOS path to the gateway. 

l Minimize Radio Frequency Interference (RFI) such as other equipment
antennas, especially those operating in the same frequency range.  This includes
other nodes.  If other antennas are required nearby, mount them at different heights
tominimize interference. Additionally, the specific node frequency is selectable within
its operational range using the Node Commander® software. Set the devices to
different transmission frequencies.

l Minimize Electromagnetic Interference (EMI) such as that generated by power
transmission equipment, microwaves, switching power supplies, and other
electromagnetic sources.

l Metal Objects in close proximity to the node, especially ferrousmetals such as steel
and iron, can be problematic for wireless communications.  The larger the object, the
greater the influence. 
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4.2.1 Range Test

After establishing communication between node and gateway, use the range test in Node
Commander® to monitor the signal strength and optimally position the node, gateway, and
antennas for installation. Maximum achievable range is determined by the gateway and
node power settings (found in the device Configure menu) and is highly dependent on the
physical environment surrounding the devices.

1. Right-click on the node header, and select Communicate > Range Test.

Figure 14 - Range Test Menu

2. The total RSSI range for the node and gateway is -90 to 0dBm. The higher the value
(closer to zero), the better, but reliable communication can be achieved between 0
and -75dBm. The devicesmay still communicate between -75 and -90dBm, but could
be intermittent or result in data loss. Position the node where the best RSSI value is
observed.

Figure 15 - Range Test Statistics
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5. Connecting Sensors

The SG-Link® - LXRS®  contains an internal, rechargeable
Lithium Polymer (Li-Po) batter y. For important precautions
see Safety Information on page 95.

The SG-Link® -LXRS® wireless sensor node features two analog input channels that interface
with a wide range of available sensor technologies, essentially converting them into wireless
sensors. The node accommodates Wheatstone Bridge and analog sensors for applications in
wireless strain gauge monitoring, such as torque, force, and pressure measurement, as well as
sensors for other applications like wireless accelerometers, vibration sensors, magnetic field and
displacement sensors. Environmental sensing can be achieved with wireless RTD and wireless
thermocouplemonitoring.

The SG-Link® -LXRS® includes one channel for single ended sensor measurement, one channel
for differential sensor measurement, and an additional channel dedicated to the on-board internal
temperature sensor. Differential channels may need to be factory-set to work for specific types of
sensors.  For information about channel configurations see Differential Input Channels on page
29. For ordering information see Parts and Configurations on page 85.

5.1 Sensor Requirements

Below are guidelines for selecting sensors for use with the SG-Link® -LXRS®  . For interfacing
with sensors outside of these parameters, or not included in the examples in the following
sections, contact Technical Support (see Technical Support on page 83). 

Sensor Impedance:

l Differential input sensors for a standard SG- Link® - LXRS® should have an
impedance of either 350Ω or 1000Ω. Sensors that are 120Ω are not recommended.
For half-bridge and quarter-bridge configurations, the node impedance value is set to
match the sensor when the node ismanufactured andmust be specified at the time of
order. For more information see Parts and Configurations on page 85. Custom bridge
completion impedance values are available on request.

l Single ended sensor inputsmust have impedance that is less than 5KΩ. 
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Sensor Signal Voltage:

l Differential sensor inputs include a hardware gain and offset stage before the sensor
input signal is processed by the analog to digital voltage converter within the node.
The combination of the gain, offset, and sensor signal voltage cannot exceed the 0 to
3VDC input range of the analog to digital converter. For more information see
Differential Input Gain andOffset on page 46.

l Single-ended sensor signal voltages can only be positive voltages with respect to the
system ground and must be between 0 and 3VDC. For single-ended sensor signal
voltages outside of that range seeMeasuring Voltages over Three Volts on page 35.

Sensor Power:

l When using the internal node battery as the node power source, the total current use
for all connected sensors must be less than 50mA.  If more current is required, a
higher capacity external power source can be used for the node or the sensor. See
Sensor Power on page 26 for information about sensor power requirement
considerations and options, and see Powering the Node on page 61 for information
regrading node power options.

5.2 Wiring Recommendations

In is good practice that all sensor wiring be done with shielded cable. The shield is connected to
the system ground only at one end to avoid ground loops. For sensitive small voltage signals
(such as strain gauges) sensor wire leads should be of matched lengths so the lead resistance
for each connection is as close to the other as possible. For long lengths of wire, a system
calibration is recommended over a sensor calibration. See Sensor Calibration on page 48.
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5.3 Sensor Power

When using the internal node battery to power the node, total
sensor current draw of more than 50mA can cause permanent
damage to the node and should be avoided.

Sensors can be powered by the node or with an external power supply.  The node sensor
excitation voltage is 3VDC and can provide up to 50mA total on all channels.  If a higher voltage
or more current is required for the sensor, an appropriately sized external power supply can be
used.   For example, using the node battery for current intensive devices such as 4 to 20mA
sensors will drain the battery quickly.  For these applications, an external source is
recommended for the sensor or the node. See 0 to 3VDC Voltage Measurements on page 34
for an example of using an external source for the sensor, and see Powering the Node on page
61 for node power information.

Drain on the battery can also be limited by selecting low resource samplingmodes and low duty
sampling rates, which automatically switch the node excitation voltage off after sampling.  This
feature can also be utilized to turn switches on and off to further control resource use. See
Using the Excitation Output as a Switch on page 37.

External battery holders and ruggedized outdoor housings that accommodate D cell batteries
are available for the SG-Link® -LXRS® and can be used to extend battery operating capacity
and duration. SeeNode Accessories on page 86.

5.4 Node Channels Designations

Channel Description Pin Nomenclature
1 differential channel S
2 (reserved) --
3 on-board temperature sensor channel --
4 single ended channel Ain

Table 1 - Channel Designations
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5.5 Terminal Block Connections

When inserting the sensor leads into the terminal block, ensure the lead wire is being clamped
under the terminal screw and not the lead insulation.  If the sensor wires are a very fine gauge,
folding and tinning them may be useful to provide more area for the terminal screw to make
contact.  Failure to provide adequate connectionmay result in erroneous data.

Figure 16 - Terminal Block Numbering

Node Pin
Number

Signal

1 VXC
2 S+
3 S-
4 GND
5 S
6 Ain
7 GND
8 Vjck

Table 3 - Terminal Block Connections



SG-Link® -LXRS®Wireless Sensor Node UserManual Connecting Sensors

28

5.6 Pin Descriptions

Signal Description
Pin
Type

Range

Vjck

Node external power supply

An alternate to the node power jack. See
Powering the Node on page 61.

power
input

+3.6 to +9VDC

sufficient current
capacity for sensors

GND
Return

For node power and sensor excitation

power
return

return

VXC

Sensor excitation

Power to external sensors.  At sampling
rates under 32Hz, it is only active when the
node is sampling the sensors.

output

+3VDC

maximum combined
load on all excitation
pins is 50mA.

S+

Differential sensor input +

Positive input to the node programmable
gain amplifier (PGA). Used with S-.

input

0 to +3VDC including
gain and offset

Wheatstone Bridge
compatible sensor with
350Ω or 1000Ω input
impedance
recommended

S-

Differential sensor input +

Negative input to the node programmable
gain amplifier (PGA). Used with S+.

S

Three wire input

Used only for three wire configuration of
quarter bridge strain gauge bridges. Leave
unconnected for non quarter strain gauge
bridge applications.

input

0 to +3VDC including
gain and offset

Wheatstone Bridge
compatible sensor with
350Ω or 1000Ω input
impedance
recommended

Ain

Single ended sensor input

Routed directly to the node analog to digital
(A/D) converter. Return is nodeGND.

input
0 to +3VDC

Less than 5KΩ

Table 4 - Node Pin Descriptions
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5.7 Differential Input Channels

NOTE

Differential channels are configured at the time of manufacture with optional
Wheatstone Bridge configurations and impedance values and must be
connected accordingly.  For available options see Parts and Configurations on
page 85.

The differential channels provide an input for sensors with a separate analog return.  The
measurements are taken with respect to the analog return, instead of the system ground, in
order to provide better protection for small measurements fromEMI, RFI, and other sources of
signal noise. The primary use of these channels is for strain gauges, pressure transducers, load
cell,s and other devices that can utilize aWheatstone Bridge configuration. The SG-Link® -
LXRS® is available in standard configurations for full, half, or quarter Wheatstone Bridge
operation, at various impedances.SeeDifferential Sensors on page 30. Custom configurations
are also available.  For configuration and ordering options see Parts and Configurations on
page 85.

The differential measurement channels provide a +3VDC excitation voltage to the sensor and
measures the resulting sensor signal output. The sensor signal goes through a programmable
gain amplifier (PGA) and is then processed in the node by a 12-bit analog to digital (A/D)
converter over the 3VDC range.  The resolution of the sensor measurement is dependent on
the operating range of the sensor.  If the application is such that only a small portion of the
3VDC range is being utilized, better resolution can be achieved by increasing signal
amplification and by zeroing the sensor baseline in the appropriate offset biasing range. 

Figure 17 - Differential Channel Signal Processing
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5.7.1 Differential Sensors

Sensors that are classified as differential sensors often utilize a Wheatstone Bridge
configuration.  These sensors are essentially a resistive load that use the bridge
configuration to detect very small resistive changes and produce a precise voltage output as
a result.  Some examples include strain gauge elements or strain gauge-based sensors,
such as some load cells and pressure transducers, as well as some soil moisture,
temperature, and other sensors.  For use with the SG-Link® -LXRS®  , sensors with an
impedance of 350Ω or 1000Ω are recommended. 

Calibration in the Node Commander® software for these devices varies depending on the
type of sensor and includes using the a calibration wizard for strain gauges.  The following
diagrams show how to connect these types of sensors.See Sensor Calibration on page 48
for more information.

Figure 18 - Full Bridge Wiring
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Figure 19 - Half and Quarter-Bridge Wiring
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5.7.2 Measuring Small Voltages

Some sensor types that have small signal voltages (around 20mV or less) may be better
measured by biasing the sensor signal to the mid range of the node input range with a
voltage divider, as shown in Figure 20 - Small VoltageMeasurement.

Channel configuration will include adjusting the gain setting accordingly in the Node
Commander® software. 

Figure 20 - Small Voltage Measurement
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5.8 Single-Ended Input Channels

Single-ended channels are designed to measure voltageswith reference to the system ground
and can accommodate many analog sensors types including accelerometers, pressure
transducers, geophones, temperature sensors, inclinometers, and more.  These channels can
also be used tomeasure reference voltages. 

Sensors that operate on 3VDC can be powered with the node excitation voltage. Alternately
sensors can be powered with an external source.  For an example of how to connect an
external supply see 0 to 3VDC VoltageMeasurements on page 34.

The single-ended channels canmeasure signals from 0 to +3VDC with reference to the system
ground. Sensor output must be positive going voltage in order to operate correctly with the SG-
Link® -LXRS®  . If the sensors output is greater than 3VDC a voltage divider can be used to
decrease the scale. SeeMeasuring Voltages over Three Volts on page 35. The impedance of
the sensor must be less than 5KΩ.

The sensor output signal is processed in the node by a 12-bit analog to digital (A/D) converter,
over the 3VDC range. The resolution of the sensor measurement is dependent on the full scale
output range of the sensor. The closer it is to three volts, themore resolution will be achieved. 

The following sections provide examples of how various sensors can be connected to the
node. For other applications or those outside of the operating parameters listed above, contact
LORD MicroStrain® Technical Support (see Technical Support on page 83 for contact
information).

Figure 21 - Single Ended Signal Processing
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5.8.1 0 to 3VDC Voltage Measurements

Sensors that operate in the 0 to 3VDC range are ideal for the node inputs. Resistive loads
that are not differentially measured, such as string potentiometers, are easily measured by
the node single-ended channels.  Power is provided by the node excitation voltage and
measured on a single-ended input, as shown below.

Reference power supply signals between 0 and 3VDC can be measured by connecting
directly between the signal input pin (Ainx) and ground (GND).

Sensors that have voltage requirements outside of the range of the node excitation voltage
can be powered externally with another source.  The sensor output can still be connected
directly to the node input as long as it is between 0 and 3VDC.  For sensor outputs over
3VDC seeMeasuring Voltages over Three Volts on page 35.

Figure 22 - 0 to 3VDC Measurements
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5.8.2 Measuring Voltages over Three Volts

Voltages over three volts can bemeasured with the use of a voltage divider circuit. Thismay
be necessary if a sensor is powered from an external source.  The same circuit can also be
used tomeasure reference power supplies over +3VDC.

The value of the voltage divider resistors will need to be determined, as required for the
application. A 10KΩ resistor is recommended for the input to the node channel, leaving only
one resistor to calculate.
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5.8.3 Measuring Small Currents (4 to 20mA Sensors)

Sensors with small currents, such as 4 to 20mA sensors, can be used with the nodes by
adding a precision sampling resistor across a single-ended input channel to the node. An
example circuit is shown in Figure 23 - Small Current Measurements .

Because the sensor output can be as much as 20mA it is recommended that an external
source be used to power the sensor.  When running on the internal node battery, the node
excitation can only supply 50mA to all sensors, so 20mA would be a significant portion and
would drain the battery quickly.  For battery life and current draw information see Using the
Internal Node Battery on page 63. The current limitations can be mitigated by using an
external power source for the sensor or the node.  If using node excitation power is the best
for the application, drain on the battery life can be limited by only switching the node
excitation voltage on just before sampling and then turning it off afterward.  This happens
automatically at low duty sampling rates (32Hz or lower) and can be set up for other sample
rates with external circuitry. For more information see Using the Excitation Output as a
Switch on page 37.

Figure 23 - Small Current Measurements
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5.9 Using the Excitation Output as a Switch

At low sampling rates (under 32Hz) the node automatically switches the excitation voltage
output off when the sensor is not being sampled, in order to conserve battery life.  This feature
can also be used in applicationswhere a switch is desired, such as for turning sensor power on
and off when the sensor is powered by the node but has a large current draw.  It can also be
used as a general purpose switch, such as for controlling a relay or transistor.  The same
limitations apply as to a sensor; the device must operate on 3VDC and not require more than
50mA when combined with all other sensor current draw.  To use the excitation output in this
way, connect the control line of the device (example: relay coil or NPN transistor base) to the
excitation pin on the node terminal block (SP+) and reference (example: other side of the relay
coil or the NPN transistor emitter) to the node ground pin (GND).

5.10 Thermocouples

Thermocouples can be used on the differential input channels by simply adding a high-
impedance resistor to the input. An example circuit is shown in Figure 24 - Connecting a
Thermocouple.

Thermocouples should be calibrated by first selecting the appropriate baseline offset range,
output range, or gain and then applying know loads and calculating the slope and offset values. 
Using water as the known load medium (submerging the thermocouple in ice and hot water
baths) is a simplemethod that can be used for calibration.

Figure 24 - Connecting a Thermocouple
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5.11 On-board Temperature Sensor

l The SG-Link® -LXRS® has an on-board, solid state temperature sensor mounted on
the surface of the circuit board.

l The temperature sensor output is connected to channel 3 of the SG-Link® -LXRS®

l The temperature sensor has a measurement range of -25˚C to +70˚C range with an
accuracy of ± 0.5˚C@25˚C.

l The sensor is made by Texas Instruments (part number LM60).  Specifications may
be found on themanufacturer’s website.
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6. Sensor Settings

LORD MicroStrain® sensor nodes are designed to accept many sensor types. The sensor channel
configurationmenus includes settings for measurement units, conversion values, and gain
settings.

Sensor readings can be displayed and recorded in volts, A/D value (bits), or engineering units.
There are preset measurement units, as well as a user-defined field. Because the wireless sensor
system is digital, the analog voltage readings from the sensors are converted into a digital
equivalent value based on the volt-to-bit scale of the internal analog to digital voltage converter
(A/D converter). A/D value can be read directly or further converted to engineering units by
applying conversion values and a conversion formula.

Some sensors also require calibration. Calibration incorporates coefficients that normalize the
sensor output to a known reference device in order guarantee accuracy of the sensor readings.
For more information see Sensor Calibration on page 48.
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6.1 Measurement Units

Sensor measurement units are set in the channel Configurationmenu.

1. To enter the Configurationmenu, right-click on the Node heading and select Configure >
Configure Node. The Channels tab displays channel options available for the current node.

Figure 25 - Channel Configuration Menu

2. Select the type of measurement from the Classmenu, and then select Units.

Figure 26 - Select Sensor Units
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6.2 Conversion Values

The conversion values include the slope, offset, gain, scale, and formula used to convert the
sensor A/D value to engineering units. The A/D value (bits) are the digital representation of the
sensor voltage output. The type of sensor, channel, and desired engineering units determine
what conversion values are available. The values are entered through the Node Commander®

software and saved in the nodememory for the applicable node channel.

NOTE

In order to report accurate readings, many sensors require calibration. 
Calibration coefficients normalize the sensor output to a known
reference device and are often expressed in the measurement unit
conversion values. Calibration accounts for the slight variations between
sensor elements, wiring, system electronics, sensor mounting, and
environmental conditions.

The conversion values can be determined mathematically from the sensor sensitivity
specifications, from the sensor manufacturer calibration data, or through a calibration process.
Calibration incorporates coefficients that normalize the sensor output to a known reference
device in order guarantee accuracy of the sensor readings, especially when making small or
precise measurements. See Sensor Calibration on page 48 for more information. Not all
sensors require calibration.

Conversion Formula:The default formula assumes a linear relationship between the A/D
value (bits) and engineering units and is expressed mathematically as y=mx+b, where y is the
engineering units at a given point (measurement), m is the slope of the line that represents the
linear ratio, x is the A/D value at a given point, and b is the fixed zero load offset of the sensor.

Slope: The slope is the ratio of A/D value (bits) to engineering units (EU) that is used to convert
the sensor measurements, or bits per EU. The slope conversion value will vary depending on
the engineering units desired. For example, if the units are ameasurement of force in pounds,
the desire slope conversion would describe how many bits equal one pound (bits/pound).
Mathematically, the slope ism in the formula y = mx +b.

Offset: The offset value is the starting output value of the sensor with no load applied.
Mathematically, the offset is b in the formula y = mx +b.
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Effective Range: Once the formula, slope, and offset values are applied, the sensor
measurement range, in engineering units, is calculated. This is the effective range and is based
on the resolution of the node. For example, a 16-bit node will have 65536 A/D values and a 12-
bit node will have 4096 A/D values. The number of A/D values per EU (slope), multiplied by the
total number of A/D values, minus the offset, determines the effective EU range of the sensor.
The effective range does not take gain or offset scale into consideration.

Input Range (Gain): This sets the amplification of the signal within the node and is only
available for channels with differential inputs and gain amplifiers.

Offset Scale (with Auto Balance):This feature is only available for channels with differential
inputs, and assigns the position and value of the no load measurement of the sensor.  The
offset scale level adjusts the operating window of the sensor measurements in reference to the
entire range. For example, in mid scale the sensor no load measurement will be placed in the
middle of the range, providing 50% of the range for positive readings and 50% of the range for
negative readings. Once the scale level is selected, the Auto Balance procedure is used to
assign the actual sensor no-loadmeasurement to the designated scale.

l Low is for positive-going signals (zero at 25% of total range).

l High is for negative-going signals (zero at 75% of total range).

l Midscale is for and positive and negative-going signals (zero at 50% of range).

Figure 27 - Offset Scale Setting
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The conversion values can be entered in two menus. The channel Configuration menu has
more options than the Calibration Coefficientsmenu, but both are acceptable ways to enter the
values and formulas.

Figure 28 - Abbreviated Conversion Values Menu

Figure 29 - Advanced Conversion Values Menu
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6.2.1 Calculating a Linear Slope

A data analysis tool, such as Microsoft Excel, can be used determine the slope of a linear
relationship between sensor output A/D value (bits) and engineering units. This is not a
calibration, unless a calibrated reference device is used to measure the applied loads. For
information and examples for determining calibrations coefficients see Sensor Calibration
on page 48 .

Here is an example, using Excel:

1. Open a blank spreadsheet.

2. Enter the A/D value (bits) measurements and applied load in the desired engineering
units in two columns. Enter A/D value is in the left column (x-axis value) and the
applied load in the right (y-axis value).

3. From the Insert menu, select Chart > Scatter. Select the preferred format.

Figure 30 - Generate a Scatter Chart
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4. Right-click on the graphed line, and select Add Trendline.

5. Designate the line as Linear, and check the option to Display the Equation on the
chart.

Figure 31 - Plot Trendline

6. The formula of the line is y=mx+b, where y is the engineering units at a given point
(measurement),m is the slope of the line that represents the linear ratio, x is the A/D
value at a given point, and b is the fixed zero load offset of the sensor. Enter the slope
and offset as the conversion values for the sensor channel under the applicable
engineering units. In this example, enter 0.1338 for the slope and -282.36 for the
offset for the pounds units conversion values on themeasured channel.

Figure 32 - Slope and Offset Values
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6.2.2 Differential Input Gain and Offset

The combination of the gain, offset, and sensor signal cannot exceed the 0 to 3VDC input of
the analog to digital converter within the node. See Example Gain and Offset Calculations
on page 47.

l Resolution: Applying gain to the sensor signal can be used to maximize the
measurement resolution. The more of the range that is used, themore digital counts
are available to measure the signal, which typically means higher resolution
measurements. Limitations to the gain adjustment are the sensor's measurement
capabilities and the 0 to 3V input range of the node. The signal produced after gain is
applied to the sensor at full scalemust not exceed the input range of the node.

l Offset Scale:The scale setting positions the no-load measurement of the connected
sensor within the 0 to 3V range of the node input. The range of A/D counts that
corresponds with the 0 to 3V node input depends on the resolution of the node. For
example, a 12-bit node will have a full scale bit range of 4096 and a 16-bit node will
have a full scale bit range of 65535. A mid-range setting positions the baseline offset
in the middle of the range (1.5V or full scale bits*1/2) and is used for sensors with
negative and positive going signals. The low-range setting positions the baseline
offset in the bottom quarter range (75mV or full scale bits*1/4) and is used for sensors
with mostly positive going signals. The high-range setting positions the baseline offset
in the top quarter of the range (2.25V or full scale bits *3/4) and is used for mostly
negative going signals.

Figure 33 - Differential Input Resolution and Offset (16-bit Node)
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Example Gain and Offset Calculations

EXAMPLE 1:

Sensor signal range: 0 to 50mV
Gain setting: 21
Baseline offset range setting:Mid-range

Calculations:

50mV * 21 = 1.05V (maximum voltage of sensor signal with gain)
1.05V + 1.5V = 2.55V ( maximum input voltage to node with gain and offset)

Calculated node input over sensor range: 1.5 to 2.55V

This is a good setting because the node input voltage is within the 0 to 3V range.

EXAMPLE 2:

Sensor signal range: 0 to 50mV
Gain setting:30
Baseline offset range setting: Low-range

Calculations:

50mV * 30 = 1.5V (maximum voltage of sensor signal with gain)
1.5V + 75mV = 2.25V ( maximum input voltage to node with gain and offset)

Calculated node input over sensor range: 75mV to 2.25V

Thismay be a better setting than in Example 1 because the gain is higher, which could increase the
resolution of themeasurement. The node input voltage is still within the 0 to 3V range.

EXAMPLE 3:

Sensor signal range: 0 to 50mV
Gain setting:75
Baseline offset range setting: Low-range

Calculations:

50mV * 75 = 3.75V (maximum voltage of sensor signal with gain)
3.75V + 75mV = 4.5V ( maximum input voltage to node with gain and offset)

Calculated node input over sensor range: 75mV to 4.5V

This setting will not work because the node input voltage is outside of the 0 to 3V range.
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6.3 Sensor Calibration

Many sensors require calibration coefficients to accurately report measurements. Methods for
determining the calibration coefficients depend on the type of sensor measurement and
application. The Node Commander ® software facilitates multiple calibration methods. 
Calibration calculators for some applications are also available by contacting LORD
MicroStrain® Technical Support.See Technical Support on page 83.

l Sensor manufacturer’s specifications or calibration: The slope and offset
values, or the data to derive them, are provided with the sensor by the manufacturer
to prove its accuracy and describe expected voltage output.   Some sensors are
calibrated individually, while others are manufactured to a standard sensitivity value
(plus or minus some tolerance), which is provided in the device specifications.

l Sensor lab calibration: If the manufacturer's calibration is not available or
outdated, calibration of the sensor can be performed with calibrated equipment in a
controlled environment. The calibration equipment and process will typically be
traceable to an industry standard, such as NIST or ASTM in the United States. Fixed
loads are applied to the sensor while the sensor output is recorded. The load is
applied or measured by a calibrated reference device. The known load value from the
calibrated device is then plotted against the measured output of the sensor to
determine the calibration slope and offset. In Node Commander ® this can be
accomplished by taking sensor readingswhile applying the known loads.

Sensor wiring, tolerances in system electronics, and differences in mounting techniques are
examples of systemic variables that can influence the sensor readings.  Sensors that are
making small measurements or are otherwise sensitive to these slight differences may benefit
from a system calibration. The following techniques are system calibrations:

l System shunt calibration (internal and external): This option is only available for
Wheatstone bridge-type sensors (such as strain gauges) and utilizes a calibration
wizard in Node Commander®. In the shunt calibration process, an internal or external
precision resistor is used to load part of the sensor bridge while the sensor remains
unloaded.  The bridge output is measured and used as a loaded calibration point for
the sensor.  In addition to the no-load value it can be used to derive the calibration
slope and offset. The internal shunt resistor is suitable for most applications, however
an external shunt may be beneficial in high gain scenarios.
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l System field calibration: The field calibration is a similar methodology to the
sensor lab calibration. Known loads are applied to the sensor while the sensor output
is recorded.  The load is applied or measured by a reference device. In this scenario,
the sensor may be installed in final field configuration, and the load may be applied
with the actual stimulus that the sensor will bemonitoring. The known load value from
the reference device is then plotted against the measured output of the sensor to
determine the calibration slope and offset. In Node Commander ® this can be
accomplished by taking sensors readingswhile applying the known loads.
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6.3.1 EXAMPLE: Lab or Field Calibration

The lab and field calibrations use similar methodology.See Sensor Calibration on page 48.
The primary difference is the traceability and calibration environment. Lab calibrations are
performed in controlled environments with traceable equipment and procedures. Field
calibrations aremore improvised, although calibrated equipment can still be used to improve
accuracy.

NODE:V-Link® -LXRS® ,16 bit (65536 A/D values)

CHANNEL TYPE: differential analog input, 0 to 3VDC input range

SENSOR TYPE: load cell

SENSOR PARAMETERS: application voltage range: +/-20mV

This is the expected output voltage of the sensor based on the range of force being
measured in the application and the sensitivity of the sensor (V/engineering units)

DESIRED OUTPUT: engineering units (EU), force (lbs)

PROCEDURE:

1. Open Node Commander®, and establish communication with the gateway and node
(see SystemOperation Overview on page 10).

2. Right-click on the node heading and select Configure > Configure Node. Select the
check-box for Channel 1, which is where the strain gauge is connected, and then
select the Configure button.

Figure 34 - Node Configuration Menu
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3. Use the following settings (Figure 35 - Channel Settings):

a. Conversion Coefficients, Class: A/D value

b. Conversion Coefficients, Units: bits

c. PGA Settings, Hardware Gain: 104

d. PGA Setting:Midscale (for positive and negative going signals)

4. Select the Auto Balance button to tare the no-load value of the strain gauge. ClickOK
to apply the node settings and exit configuration.

Figure 35 - Channel Settings

5. Right-click on the node heading, and then Sample > Stream > Start.

Figure 36 - Start Node Streaming
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6. The streaming graph shows the bit output of the channel. 

7. Using a calibrated tool (or some other way of applying and measuring a known load)
and apply loads to the sensor at a number of intervals over the expected range of
use.  At each of the calibration intervals, record the applied force  and the
corresponding sweep value on the y–axis of the graph (the A/D value output of the
sensor).

a. Zoom in and out on the graph by un-checking the Auto Y-Axis Zoom box,
and then right clicking on the graph and selecting Zoom In.  Draw a box
around the desired area to zoom in on.

b. Adjust the Y-AxisWidth from the field next to the Y-Axis Zoom.

c. End sampling by clicking the red X box on the StreamingGraph tab.

Figure 37 - Node Sampling
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8. After making all measurements, calculate a slope from the data using the formula
y=mx+b in a data analysis program, such as Microsoft Excel. See Calculating a
Linear Slope on page 44.

9. Return to the Node Configuration screen for the sensor channel, and select the
Conversion Coefficients Class and Units, and enter the Slope and Offset values
derived in the data analysis program.

Figure 38 - Enter Calibration Values

10. Save the values, and exit configuration. This is the end of a lab calibration.

11. For field calibrations, bbegin node data streaming again with no load on the sensor.

12. Observe the value in the stream graph. If the stream is not at zero, return to the
channel configurationmenu, and adjust the offset by increasing or decreasing the
value.

13. Once the offset has been zeroed, verify the calibration by applying known loads on
the sensor throughout the load range, observing and verifying the measurement in
engineering units.
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6.3.2 EXAMPLE: Manufacturer Calibration

NODE: V-Link® -LXRS® ,16 bit (65536 A/D values)

CHANNEL TYPE: differential analog input, 0 to 3VDC input range

SENSOR TYPE: pressure transducer, voltage output, positive going

SENSOR PARAMETERS:

From themanufacturer calibration sheet included with the sensor;

sensor range: 0-250 psi
sensor zero load output: 0.0032 VDC
sensor full scale output (FSO) with 10V excitation: 86.07mV

From the application parameters;

sensor excitation in application: 3V supply from the node

DESIRED OUTPUT: engineering units (EU), psi

CALCULATIONS:

Because the sensor will be powered from the node with 3V, and the sensor manufacturer
calibrated it a 10V, themanufacturer full scale output (FSO) value needs to be scaled to 3V.

(3V/10V) * 86.07mV = 25.82mV

Select a gain and offset scale value appropriate for the sensor. Because the signal is
positive going in this example application, the low offset scale will provide the largest range.
With the low offset selected, the effective input range of the node is 75mV to 3V (2.25V)
(see Differential Input Gain and Offset on page 46). Calculate the highest gain possible by
dividing the actual input range by the sensor FSO.

2.25V/25.82mV = 87

The closest gain setting below optimal gain for a V-Link® -LXRS® is 75 (+/-20mV). Using a
higher gain value would exceed the input voltage capacity of the node when the sensor is at
higher pressures. This selection makes sense because the approximate input range
designation for a gain of 75 is +/-20mV (a 40mV delta minus 10mV for the low offset), which
is close to the FSO range of the sensor.



SG-Link® -LXRS®Wireless Sensor Node UserManual Sensor Settings

55

Multiply the sensor FSOby the gain setting to get the sensor voltage after amplification.

75 * 25.82mV = 1.9365V

Scale the (gained) sensor input voltage/EU ratio to the node input voltage/EU ratio to
determine the equivalent node FSOvalue (x).

1.9365V/250psi=3V/x
(250psi * 3V)/1.9365V = x = 387. 3psi

The node converts voltage inputs to A/D values. For a 16-bit node, there are 65536 A/D
values over the 3V input range. Divide the node EU FSOby the A/D value to get the ratio, or
slope, of EU to A/D value.

387.3 psi/65536 bits = 0.00591 = slope

Once the slope is entered, the sensor offset value can be measured in a data sampling
session, such as streaming. Sample the sensor channel with no load applied, and read the
EU value. Enter this as a negative value for the offset in order to have it subtracted from
readings.
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6.3.3 EXAMPLE: Internal Shunt Calibration

NODE: V-Link® -LXRS® ,16 bit (65536 A/D values)

CHANNEL TYPE: differential analog input, 0 to 3VDC input range

SENSOR TYPE: strain gauge,Wheatstone Bridge, full bridge configuration

SENSOR PARAMETERS: application voltage range: +/-2mV

This is the expected output voltage of the strain gauge based on the range of strain being
measured in the application and the sensitivity of the gauge (volts/strain).

DESIRED OUTPUT: engineering units, microstrain

PROCEDURE:

1. Open Node Commander®, and establish communication with the gateway and node.
(See SystemOperation Overview on page 10.)

2. Right-click on the node name, and select Configure > Configure Node.

3. Select the check-box for Channel 1, which is where the strain gauge is connected,
and then select the Configure button.

Figure 39 - Node Configuration Menu
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4. Use the following settings;

a. Conversion Coefficients, Class: Strain

b. Conversion Coefficients, Units: uStrain

c. PGA Settings, Hardware Gain: 104

d. PGA Setting:Midscale (for positive and negative going signals)

5. Select the Auto Balance button to tare the no-load value of the strain gauge. Observe
the value returned for the Auto Balance value.

Figure 40 - Channel Settings
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6. Select the StrainWizard.

7. Select the appropriate Bridge Type and click Next.

8. Select Use the Strain MeasurementWizard and click Next.

9. Set the following parameters:

a. Number of Active Gauges: number of a strain elements connected (for
example: 4 for a full-bridge, and 2 for a half-bridge)

b. Gauge Factor: ratio of mechanical strain to electrical output (a gauge
specification).

c. Gauge Resistance: Enter the strain gauge ohm value (a gauge
specification).

d. Shunt Resistance: 499000 ohms

Figure 41 - Strain Wizard Settings

NOTE

Touching connected sensors and test boards or charging the node battery
while acquiring datamay induce noise on sensitive sensor signals and is not
recommended.
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10. Select Calibrate.

11. Verify the calibration looks as shown in Figure 42 - Strain Gauge Calibration.  The
green line represents the output of the strain gauge. With no load applied it should sit
near the Auto Balance baseline value, represented by the red dashed line.  During
calibration, a shunt resistance (selected on the Parameters page) is applied across
the strain bridge, shown by the square pulse on the output.  The Offset value, shown
with the dashed blue line, is the average output value of the pulse and should sit
across the top of the pulse.  If the gauge has not had to time to equilibrate before
sampling, or if varying environmental factors exist, spikes in the gauge output may
occur and affect the Baseline and Offset values.  If this occurs, the Offset and
Baseline values can be adjusted to clip the spikes in the output values.  Adjust them
as needed, and select Accept when completed. 

Figure 42 - Strain Gauge Calibration
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12. Select Finish to end the Strain Wizard.  Note the slope and offset values have been
calculated automatically. 

Figure 43 - Completed Strain Wizard

13. Select OK to exit the Channel Configuration window.

14. In the Node Configuration window, select Apply to write the configuration and
calibration values to the node.

15. Select OK to exit.

Figure 44 - Apply Node Settings
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7. Powering the Node

Apply only the input voltage range specified for the node in the
polarity indicated.  Failure to do so could result in personal
injury and permanent damage to the node. For important
safety considerations see Safety Information on page 95.

The node can be powered with the internal battery or an external source.  These sources cannot
be used simultaneously.  When the node is manufactured, the switch is set to operate using the
internal battery.

External battery holders and a ruggedized outdoor housing that accommodates two D cell
batteries are available for the SG-Link® -LXRS® and can be used to extend battery operating
capacity and duration. For more information see Node Accessories on page 86. 
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7.1 Selecting the Power Source

There is user-accessible switch to select the power source.  The following steps describe how
to change between internal battery operation and an external power source:

The SG-Link® - LXRS®  contains an internal, rechargeable
Lithium Polymer (Li-Po) batter y. For important precautions
see Safety Information on page 95.

1. Verify the node power switch is in the OFF position and no external power is applied.

2. Use a small flat head screwdriver to push the recessed switch fully to the desired
position, as indicated in Figure 45 - Power Source Selection. The figure shows the
node configured for an internal power source.

Figure 45 - Power Source Selection
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7.2 Using the Internal Node Battery

The SG-Link® - LXRS®  contains an internal, rechargeable
Lithium Polymer (Li-Po) batter y. For important precautions
see Safety Information on page 95.

When the internal node switch is set for internal power, the node is powered by a rechargeable
250mAH lithium polymer battery. The battery is not user-serviceable.

Node battery life is highly dependent on the number and type of sensors connected, as well as
operational parameters such as sample mode and rate.  More active channels and higher
sample rates equate to decreased battery life.  The following graph shows an example
approximation of the battery life for a SG-Link® -LXRS® with different strain gauge sensor
configurations over a range of sample rates operating in Synchronized Sampling mode.  For
additional SG-Link® -LXRS® power specifications see Power Profile on page 93.
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7.3 Charging the Node Battery

Use only the power supply specified for the node to charge
the battery.  Using a power supply above the rated voltage
could cause personal injury and permanent damage to the
node. For important safety considerations see Safety
Information on page 95.

NOTE

Touching connected sensors and test boards or charging the node battery
while acquiring datamay induce noise on sensitive sensor signals and is not
recommended.

1. Plug the node power supply into the node, and into a 120/240VAC, 50/60Hz AC
power source. Use only the power supply specified for the node. Use the supplied
power plug adapters, as needed.

2. Monitor the status of the charge indicators. For indicator meaning see Device Status
Indicators on page 71. Continue charging until the indicator turns green to indicate a
completed charge. Charging takes approximately 6-8 hours from a full discharge. 

Figure 46 - Node Charging
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7.4 Connecting an External Power Supply

Apply only the input voltage range specified for the node in the
polarity indicated.  Failure to do so could result in personal
injury and permanent damage to the node. For important
safety considerations see Safety Information on page 95.

When the internal node switch is set for external power, the nodemay be directly powered by
the power supply specified for charging the node, or another regulated AC to DC power supply
with the appropriate output parameters.  It can also be powered by an external battery or other
regulated DC supply. The supplymust deliver a stable voltage between 3.2V and 9.0VDC and
be capable of sourcing at least 50mA.  Power supplies over 9VDC, such as vehicle batteries,
can be used by installing a step- down regulator (for SG-Link® - LXRS® power use
specifications see Power Profile on page 93). External battery holders and ruggedized outdoor
housings that accommodates D cell batteries are available for the SG-Link® -LXRS®  . See
Node Accessories on page 86.

External power is applied through either the power supply jack or the terminal block
connectors. Do not connect both. Observe connection polarities or the nodemay be damaged.

Figure 47 - External Power Connections
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8. Troubleshooting

8.1 Troubleshooting Guide
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Problem Possible cause and recommended solution

1. POWER

gateway or node does
not turn on, or node
does not charge

1.1 power switch is off

The status indicator LED on the device will be off.  Turn the
device on, and the status indicator LED should illuminate.

1.2 external power is off or miswired

Verify the device power source is connected correctly and
turned on.

1.3 wrong power supply

Using a power supply other than the one specified the device or
an external supply that is outside of the device operating range
could result in permanent damage to the device or cause it to
not work properly.

1.4 node internal source select switch is set incorrectly

When the node is manufactured, it is set to internal battery
operation, but it can be configured to accept an external source.
When set to an external source, the battery cannot be charged.

1.5 node battery is dead

If the node power source selector is set to internal and the node
will not power on, attempt to charge the node battery. If the
battery needs to replaced, contact LORD MicroStrain ®

Technical Support (See Technical Support on page 83).

1.6 node battery fault

If the battery charge indicator on the node is only dimly
illuminated when charging is attempted, a battery fault condition
has occurred. Unplug power and then plug it back in. The
indicator should turn on brightly, indicating charging.

1.7 sensors are drawing too much current

The node battery can only supply a limited amount of power to
the connected sensors.  If an over-current condition occurs, the
node will shut down.  Consider powering the node or sensors
with an external source. 
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Problem Possible cause and recommended solution

1.8 node or gateway is damaged

If all power settings and connections have been verified, and the
node is still unresponsive, contact LORD MicroStrain ®

Technical Support (See Technical Support on page 83).

2. COMMUNICATION

no communication to
the gateway or node

2.1 node or gateway has no power

Verify the node and gateway have power applied and applicable
power switches are on. Power is indicated on both devices by a
status indicator LED.

2.2 gateway has no communication with the computer

Verify gateway communication in the software. Check, remove,
and reconnect communications and power cables as
applicable. 

l For serial gateways, verify the COMport setting.

l For USB gateways, verify the drivers are installed on the
computer (included with Node Commander®) and that the
software has had sufficient time to detect it.

l For Ethernet gateways, use Live Connect™ to verify
communications on a DHCP network. Check that the
extended timeouts are enabled in the Node Commander®

Edit > Preferencesmenu, under Devices. Once
communication has been established the network
configuration can be changed.

2.3 node cannot be configured

Observe the node status indicator LED to determine what state
it is in: boot, idle, sample, or sleep. If the node is sampling or
sleeping, it cannot be configured. In Node Commander ® ,
execute the Stop Node command to put the node in idle state
and allow configuration to occur.

If the user inactivity timeout is set very low, the configuration
menuwill have to be entered quickly, before the timeout occurs,
putting the node back in a sample or sleep state.
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Problem Possible cause and recommended solution

2.4 node is out of range

Perform a bench test with the node and gateway in close
proximity to verify they are operational.  For range test and
installation recommendations see Range Test on page 23.  The
system has been tested to operate with the node and gateway
up to 2km apart with clear line of sight.

2.5 node is not in normal start-up mode

If the node status indicator shows the node booting in a mode
other than the normal boot mode, it can be bypassed by toggling
the node ON/OFF switch rapidly three times, then leaving it in
the ON position for normal power up. In normal boot mode the
conmmunication can be established with automatic node
discovery or manually once the boot process is complete and
the node is in the idle state. Start upmode can then be changed
in the software.

2.6 node is sampling

Observe the node status indicator LED to determine what state
it is in: boot, idle, sample, or sleep. If the node is sampling, it
cannot be configured. In Node Commander®, execute the Stop
Node command to put the node in idle state, allowing
configuration to occur.

2.7 node is sleeping

Observe the node status indicator LED to determine what state
it is: boot, idle, sample, or sleep. If the node is sleeping, it cannot
be configured. In Node Commander®, execute the Stop Node
command to put the node in idle state, allowing configuration to
occur.

2.8 gateway or node is damaged

Verify all connections, power, and settings.  If available, try
installing alternate nodes and gateways one at a time to see if
the faulty device can be identified.  If no conclusion can be
determined, or to send a device in for repair, contact LORD
MicroStrain® Technical Support (See Technical Support on
page 83).
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Problem Possible cause and recommended solution

3. DATA ACQUISITION

sensor data is missing
or incorrect

3.1 no communication to node or gateway

Verify connections and power to the node and gateway. Verify
they are powered on and communicating in the software. Enter
a configurationmenu to verify that the node can be accessed.

3.2 sampling settings are incorrect

If the sampling mode, rate, or duration are not performing as
expected, enter the node configuration menu, and verify the
sampling settings.

3.3 sampling has not started

If sampling is occurring, the mode will be displayed next to the
node name in Node Commander® . The node device status
indicator will also be flashing the sampling mode code. If the
node is not sampling, activate it in the software or with a sample
on start up boot sequence.

3.4 sensor is not connected correctly

Verify sensors connections and wiring.  For non standard
connections contact LORD MicroStrain® Technical Support
(See Technical Support on page 83).

3.5 sensor channel not configured correctly

Verify that the sensor is configured on the correct channel and
has been enabled for data acquisition. 

3.6 sensor calibration is invalid

If possible, perform a field verification of the sensors by applying
known loads and comparing the measured values.  In the
channel configuration settings, verify that the sensor channel
units are selected correctly.  Verify that the calibration
calculations are correct.   Verify that the gain and offset range
are correct and that the baseline offset is set with Auto Balance,
as applicable.   Verify that the calibration values (slope and
offset) are correct.  Verify that all parameters were written to the
node channel. Recalibrate as needed.
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8.2 Device Status Indicators

The following is a complete list of the SG-Link® -LXRS® status indicators.

Indicator Symbol Behavior Node Status
Battery charge
source
indicator

OFF No power source detected

ON green Charging source detected

Battery charged
indicator

OFF Node not charging

ON bright red Node battery charging

Battery charged
indicator

OFF Node charge status unknown
ON green Battery fully charged
ON green and
battery charging
indicator ON red

Battery fault condition, reset
by unplugging power and
then plugging it back in

Device status
indicator

OFF NodeOFF or sleeping
OFF, with
occasional flash

Node sleeping with radio
check intervals enabled

Ten rapid flashes
Node booting normally and
sending out a status
message.

1 second pulse
(approximate)

Node active and idle

ContinuouslyON
Node logging or streaming
data

Pulses at sample
rate

Node sampling in low duty
cycle

Pulses for each ping
Node sending out
communication requests

Pulses at very high
speed

Node being range tested

Several rapid pulses
Node EEPROM is being
read or written

Four slow pulses
when power is
initially applied

Fault condition

Five slow pulses
when power is
initially applied

Fault condition

Table 5 - Device Status Indicators
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8.3 Using the Node Tester Board

The node tester board is used to verify node and network functions before sensors are
connected, or for diagnostic purposes. The node tester board provides a fixed load so system
functions can be verified including basic operations not related to the sensor, such as
communication and sampling. A fixed load is applied to the differential input by pressing the
load button. The SG-Link® -LXRS® also features a photo cell that can be used to apply a
variable load the single-ended channel. Adjust the load by changing the amount of light on the
face of the photo cell.

There are various impedance value node tester boards available, depending on the node it is
being used with. See Parts and Configurations on page 85 for configuration options and part
numbers.  Table 6 - Tester Board Configuration describes the strain gauge load settings
available. This setting must match the type of node channel that is being tested. For example if
the node is a quarter-bridge node, the setting on the tester board must be the same. The
configuration chart is also printed on the underside of the board.

NOTE

The switches may come with a protective film covering them.  Simply peel the
film off to access the switches.

Configuration SW 1
position

SW 2
position

SW 3
position

SW 4
position

Full Bridge ON ON ON OFF
Half Bridge OFF OFF ON OFF
Quarter Bridge OFF OFF OFF ON

Table 6 - Tester Board Configuration
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The following steps describe an example of how to use the tester board to sequence through
the primary functions of the node and the wireless system. If the results indicated in the final
steps are achieved, the system is fully operational for measuring a full bridge strain gauge. 
Other scenarios can be tested as needed.

1. Set the jumpers for Full Bridge operation, using a small flat head screw driver to fully
push the switch into the desired position.

2. Verify the node is powered off and unplugged. 

3. Plug the node tester board into the node in the orientation shown, and screw the
board in place.

Figure 48 - Node Tester Board Installation

4. If not already completed, set up the Wireless Sensor Network equipment and install
the Node Commander® software.See SystemOperation Overview on page 10.

5. Launch theNode Commander® software, and establish communications with the
gateway and node.
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6. Enter the node channel configuration menu by right-clicking on the node heading in
Node Commander ® and selecting Configure > Configure Node, and then the
Channels tab.

Figure 49 - Node Configuration Menu

7. Select the check box for Channel 1, which is where the Node Tester Board is
installed, and then select Configure.

Figure 50 - Node Channel Configuration
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8. Use the following settings for the node tester board.

a. Conversion Coefficients, Units: uStrain

b. Conversion Coefficients, Class: Strain

c. PGA Settings, Input Range: +/-2.5mV

d. PGA Setting:Midscale

9. Select the Auto Balance button to tare the no load value of the tester board.

Figure 51 - Channel Settings
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10. Select the StrainWizard.

11. Select Full Bridge for the Bridge Type and click Next.

12. Select Use the Strain MeasurementWizard, and click Next.

13. Set the following for the Node Tester Board

a. Number of Active Gauges: 4

b. Gauge Factor: 2

c. Gauge Resistance: Enter the node tester board ohm value.

d. Shunt Resistance: 499000 ohms

Figure 52 - Strain Wizard Settings
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14. Select Calibrate.

15. Verify the calibration looks as shown in Figure 53 - Strain Gauge Calibration.  The
green line represents the output of the strain gauge. With no load applied it should sit
near the Auto Balance baseline value, as shown, and is represented by the red
dashed line.  During calibration, a shunt resistance (selecting on the Parameters
page) is applied across the strain bridge, shown by the square pulse on the output. 
TheOffset value, shown with the dashed blue line, is the average output value of the
pulse and should sit across the top of the pulse.  If the gauge has not had to time to
equilibrate before sampling, or varying environmental factors exist, spikes in the
gauge output may occur and affect the Baseline andOffset values.  If this occurs, the
Offset and Baseline values can be adjusted to clip the spikes in the output values. 
Adjust them as needed, and select Accept when completed. 

Figure 53 - Strain Gauge Calibration
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16. Select Finish to end the Strain Wizard.  Note that the slope and offset values have
been calculated. 

Figure 54 - Completed Strain Wizard

17. Select OK to exit the channel Configuration window.

18. In the Node Configuration window, select the Streaming tab.  Uncheck Continuous
Streaming, and set the TimeDuration to 15 seconds.

19. Select Apply to write configuration and calibration values to the node. Select OK to
exit. 

NOTE

Touching connected sensors and test boards or charging the node battery
while acquiring datamay induce noise on sensitive sensor signals and is not
recommended.

NOTE

There are many sampling options available in the Node Commander ®

software. The following describes just one option, for illustrative purposes. 
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20. Right-click on the Node heading and then select Sample > Stream > Start.

21. As soon as Start is selected, the node will start collecting data for a duration of 15
seconds.  During that time, press and release the load button on the node tester
board to shunt the resistive load on and off. Verify the result is as shown in the figure
below. The pulse value should equal tester board ohm value. Testing is complete.

Figure 55 - Node Sampling Menu

Figure 56 - Node Tester Output Stream
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8.4 Updating Node Firmware

Under the recommendation of LORD MicroStrain® Technical Support Engineers, nodes can
be upgraded to the latest available firmware to take advantage of new features or correct
operating issues.  Node Commander® version 2.7.0 or greater can be used to update any
mXRS® or LXRS® node or gateway firmware to the most current version.  Updates are found
on the LORD MicroStrain® website.  See Technical Support on page 83 for contact and
website information.

1. Download the LXRS® Firmware Upgrade file from the LORD MicroStrain®website.

2. Once downloaded, extract the contents of the zip file into a folder on the computer. 
Verify there is a file with a .zhex extension.

3. Launch Node Commander® , and establish communication between the node and
gateway as normal.

4. Press and hold F1 on the computer keyboard.  While holding F1, right-click the node
name, and a drop-downmenuwill appear.

Figure 57 - Update Node Firmware
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5. Release the F1 key.

6. Click Upgrade Firmware, and the Node Firmware Upgrade window will appear.

7. Click Browse, and navigate to the downloaded .zhex file.

8. Click Write, and the upgrade sequence will begin.  When complete, "Upgrade
Success" will appear in the Status column.

Figure 58 - Upgrade Firmware Window
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8.5 Repair and Calibration

The SG-Link® -LXRS® has no components which require factory calibration and certification.

General Instructions

In order to return any LORD MicroStrain® product, you must contact LORD
MicroStrain® Sales or Technical Support to obtain a Return Merchandise
Authorization number (RMA). All returnedmerchandisemust be in the original
packaging including manuals, accessories, cables, etc. with the authorization
(RMA#) clearly printed on the outside of the package.  Removable batteries
should be removed and packaged in separate protective wrapping.  Please
have the LORD MicroStrain®model number and serial number as well as your
name, organization, shipping address, telephone number, and email.  Normal
turn-around for RMA items is 7 days from receipt of item by LORD
MicroStrain®.

Warranty Repairs

LORD MicroStrain® warrants its products to be free from defective material
and workmanship for a period of one (1) year from the original date of
purchase. LORD MicroStrain® will repair or replace, at its discretion, a
defective product if returned to LORD MicroStrain®within the warranty period.
This warranty does not extend to any LORD MicroStrain® products which have
been subject to misuse, alteration, neglect, accident, incorrect wiring, mis-
programming, or use in violation of operating instructions furnished by us. It
also does not extend to any units altered or repaired for warranty defect by
anyone other than LORD MicroStrain®.

Non-Warranty Repairs

All non-warranty repairs/replacements include a minimum charge. If the
repair/replacement charge exceeds the minimum, LORD MicroStrain® will
contact the customer for approval to proceed beyond theminimumwith the
repair/replacement.
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8.6 Technical Support

There are many resources for product support found on the LORD MicroStrain® website
including technical notes, FAQs, and product manuals.

http://www.microstrain.com/support_overview.aspx

For further assistance our technical support engineers are available to help with technical and
applications questions.

Technical Support

sensing_support@LORD.com

Phone: 802-862-6629
Toll Free: 800-449-3878
Fax: 802-863-4093

SKYPE:microstrain.wireless.support

Live Chat is available from the website during business hours:
9:00 AM to 5:00 PM (Eastern TimeUS & Canada)

http://www.microstrain.com/wireless
mailto:sensing_support@LORD.com
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9. Maintenance

There are no user-serviceable parts on the SG-Link® -LXRS®  .
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10. Parts and Configurations

10.1 Standard Nodes

For the most current product information, custom, and OEM options not listed below, refer to
the LORD MicroStrain®website or contact the LORD MicroStrain® SalesDepartment.

Model Number Description
LORD MicroStrain®

Part Number

SG-LINK-LXRS

l One differential analog channel

l One single ended analog
channel

l Internal temperature sensor

6308-3000

Configuration Options (specify at time of order)

l Full-bridge configuration on differential channels.

l 350Ω or 1000Ω half-bridge completion on differential channels.

l 350Ω or 1000Ω quarter-bridge completion on differential channels.

l High g-force option. Node operates in gravitational forces in excess of 550 g.
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10.2 Node Accessories

The following parts are available for use with the SG-Link® -LXRS®  . For the most current
product information refer to the LORD MicroStrain®website or contact the LORD MicroStrain®

SalesDepartment.See Product Ordering on page 89.

Description
LORD MicroStrain®

Part Number
Power supply for SG-Link® -LXRS® 6302-1000

IP66/NEMA4 rated rugged outdoor enclosure
for SG-Link® -LXRS®

6309-3000

IP66/NEMA4 rated rugged outdoor enclosure
for SG-Link® -LXRS® with two D cell battery capacity

6309-4000

IP66/NEMA4 rated rugged outdoor enclosure
for SG-Link® -LXRS® with three D cell battery capacity

6309-5000

Magneticmounting strips for outdoor enclosure 6302-4000
350Ω node tester board 6309-6000
1000Ω node tester board 6309-7000

Inductive remote power starter for nodes 6303-0300
D cell battery tray for use with wireless nodes (indoor use) 6302-0200
AA cell battery tray for use with wireless nodes (indoor use) 6302-0300

LithiumD cell battery 19 Ah capacity 6302-0000
LithiumAA cell battery 2 Ah capacity 6302-0100

Table 7 - Node Accessories
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10.3 Wireless System Equipment

Model Description
LORD

MicroStrain®

Part Number
WSDA-1000-SK Ethernet Data GatewayStarter Kit 6314-0051

WSDA-BASE-104-SK USB GatewayStarter Kit 6307-1041
WSDA-BASE-102-SK RS232GatewayStarter Kit. 6307-1021
WSDA-BASE-101-SK AnalogGatewayStarter Kit 6307-1011

WSDA-1000 Ethernet Data Gateway 6314-0050

WSDA -RGD
Ethernet Data Gateway

(ruggedized toMILS-STD-461F/MIL-STD 810F)
6314-1050

WSDA-BASE-104 USB Gateway 6307-1040
WSDA-BASE-102 RS232 Serial Output Gateway 6307-1020
WSDA-BASE-101 AnalogOutput Gateway 6307-1010

-- Node Commander® Software 6301-0300
-- Replacement USB cable 9022-0029
-- Replacement serial cable 4005-005
-- USB Gateway cable extender 6307-0900

G-Link-LXRS Wireless Accelerometer Node various models
G-Link2-LXRS Wireless Accelerometer Node various models
SG-Link-LXRS Wireless 2-Channel Analog Input Sensor Node various models
SG-Link-OEM Wireless 2-Channel Analog Input Sensor Node various models
SG-Link-RGD RuggedizedWireless Analog Sensor Input Node various models
V-Link-LXRS Wireless 7-Channel Analog Input Sensor Node various models
TC-Link-LXRS Wireless Thermocouple Node various models
DVRT-Link-LXRS WirelessDisplacement Sensor Node various models
ENV-Link-Mini-LXRS Wireless Environmental Sensor Node various models
Watt-Link-LXRS Wireless EnergyMonitoring Sensor Node various models
RTD-Link-LXRS WirelessRTD Sensor Node various models

Table 8 -Wireless System Equipment
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10.4 Warranty Information

Warranty

LORD MicroStrain® warrants its products to be free from defective material
and workmanship for a period of one (1) year from the original date of
purchase. LORD MicroStrain® agrees to repair or replace, at its sole
discretion, a defective product if returned to LORD MicroStrain® within the
warranty period and accompanied by proof of purchase. This warranty does
not extend to any LORD MicroStrain® products which have been subject to
misuse, alteration, neglect, accident, incorrect wiring, mis-programming or to
use in violation of operating instructions furnished by us. It also does not
extend to any units altered or repaired for warranty defect by anyone other
than LORD MicroStrain® . This warranty does not cover any incidental or
consequential damages and is in lieu of all other warranties expressed or
implied. No representative or person is authorized to assume for us any other
liability in connection with the sale of our products. Some states do not allow
limitations on how long an implied warranty lasts, and/or the exclusion or
limitation of incidental or consequential damages, so the above limitations and
exclusionsmay not apply to the original customer.

Terms and Conditions of Sale

Please refer to the LORD MicroStrain ® website Support page for
complete Terms and Conditions of product sales.

Terms and Conditions of Service

Please refer to the LORD MicroStrain ® website Support page for
complete Terms and Conditions of product service.

Trial System

To enable customers to try our products risk-free, LORD MicroStrain® offers a
30-day return policy on the purchase of a starter kit. In order to take advantage
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of this offer, a purchase order or payment for the starter kit is required when
the order is placed. If the product is not suited to the application, the product
may be returned within 30 days from the date of receipt for a full refund
(excluding shipping and handling), as long as the product is unaltered and
undamaged. Items can only be returned after LORD MicroStrain® has issued
an Return Material Authorization (RMA). Items must be packed to withstand
shipping, sent via freight, and pre-paid. LORD MicroStrain® will inspect the
items returned and issue a refund or credit once the items have been
examined and are deemed to be unaltered or undamaged. Non-standard or
custom productsmay only be returned with approval and a re-stocking penalty
may be assessed.  A 30- Day Return must be initiated by receiving a
RMA from LORD MicroStrain®.

10.5 Product Ordering

Products can be ordered directly from the LORD MicroStrain® website by navigating to the
product page and using the Buy feature. 

http://www.microstrain.com/wireless

For further assistance, our sales team is available to help with product selection, ordering
options, and questions.

Sales Support

sensing_sales@LORD.com

Phone: 802-862-6629
Toll Free: 800-449-3878
Fax: 802-863-4093

9:00 AM to 5:00 PM (Eastern TimeUS & Canada)

http://www.microstrain.com/wireless
mailto:sensing_sales@LORD.com
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11. Specifications

11.1 Physical Specifications

Dimensions: 58mmx 50mmx 21mm
Weight: 42 grams

Enclosure Environmental Rating: General purpose indoor
(IP67/NEMA4X rated enclosure available)
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11.2 Operating Specifications

Parameter Specification

Input channels
2 input channels: 1 full differential, 350Ω resistance or higher (with optional bridge
completion), and 1 single ended inputs (0-3 voltsmaximum), plus an internal
temperature sensor

Temperature sensor -40 °C to 70 °C range, typical accuracy±2 °C (at 25 °C)

Anti-aliasing filter bandwidth -3 dB cutoff at 250 Hz (factory adjustable)

Measurement accuracy ±0.1%full scale typical

Resolution
1 bit: 0.024%1microstrain typical for 3 wire full-bridge strain gauge when used in
accordance with LORDMicroStrain® recommendations.

DC bridge excitation
+3VDC, 50mAmaximum acrossall channels (pulsed to sensors for sample ratesof
32 Hzand below to conserve power)

Programmable gain
software programmable for differential input channels from 104 to 1800 (can be
reduced with custom configuration)

Programmable offset software programmable

Analog to digital (A/D) converter successive approximation type, 12 bit resolution

Data storage capacity 2megabytes (approximately 1,000,000 data points)

Sampling modes synchronized, armed datalogging, streaming, low duty cycle

Synchronized sampling rates 1 Hz - 512 Hz

Synchronized sampling mode
network capacity

transmit real time data from node to PC - rate dependson number of active channels
and transmitting nodes. sample ratesand # of channels are configurable. 
For example;

3 nodes, 1 channel, 512 Hz,
15 nodes, 1 channel, 256 Hz
31 nodes, 1 channel, 128 Hz
63 nodes, 1 channel, 64 Hz

Synchronization between nodes ±32μsecwith 10 second beacon interval

Synchronization rate stability ±3ppm

Armed datalogging sampling rate 1 channel enabled: 32 Hz to 4096 Hz; 2 or more channels enabled: 32 Hz to 2048 Hz

Streaming sampling rates
1 channel enabled: 736 Hz; 3 channels enabled: 617 Hzper channel; 8 channels
enabled: 424 Hzper channel

Low duty cycle sampling rates 512 Hz to 1 sample per 60minutes

Event driven monitoring user-definable event threshold trigger, 200K bytespre- event recording

Shunt calibration channel 1, internal shunt calibration resistor 499 KΩ

Radio frequency (RF) transceiver
carrier

2.4 GHzdirect sequence spread spectrum, license free worldwide (2.405 to 2.470
GHz) over 14 channels, radiated power programmable from 0dBm (1mW) to 16dBm
(39mW); Europeanmodels limited to 10dBm (10mW)

RF data packet standard IEEE802.15.4, open communication architecture

RF data downloading 8minutes to download fullmemory

Range for bi-directional RF link programmable communication range from 70meters to 2 kilometers

Status LED’s AC power, battery charging, battery charged, node status

Power internal: 3.7 volt 250mAh lithium ion rechargeable battery; external: +3.2 to +9.0VDC

Power consumption see power profile

Operating temperature
-20 ˚C to +60 ˚C with standard internal battery and enclosure, extended temperature
range optionalwith custom battery and enclosure, -40 ˚C to +85˚C for electronics
only

Maximum acceleration limit 500 g standard (high g option available)

Dimensions 58mm x50mm x21mm6 in. x 2.85 in. OD, 1.4 in. ID (for 1.38 in. shaft)

Weight 42 grams1 pound
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Parameter Specification

Enclosure material ABSplastic

Environmental rating indoor use only, unlessused with housing

ROHS compliant

Compatible gateways allWSDA®-Base andWSDA®-1000

Software SensorCloud™NodeCommander®WindowsXP/Vista/7 compatible

Software development kit (SDK)
includesdata communicationsprotocol, EEPROMmapsand sample code (OSand
computing platform independent)

FCC ID XJQMSLINK0001

IC ID 8505A-MSLINK0001

Table 9 - Operating Specification
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11.3 Power Profile

Node power use is highly dependent on the number and type of sensors connected and
operational parameters such as sample mode and rate.  More active channels and higher
sample rates equate to increased power use. Below is an example approximation of the power
use of a SG-Link® -LXRS® with different strain gauge sensor configurations over a range of
sample rates operating in Synchronized Sampling mode.  This chart can be used to
approximate external node power source requirements. For SG-Link® - LXRS® internal
battery life specifications see Using the Internal Node Battery on page 63.

Figure 59 - Example SG-Link® -LXRS® Power Profile
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11.4 Radio Specifications

TheSG-Link® -LXRS® Wireless Sensor Node employs a 2.4GHz IEEE 802.15.4 compliant
radio transceiver for wireless communication.  The radio is a direct-sequence spread spectrum
radio and can be configured to operate on 14 separate frequencies ranging from 2.405 GHz to
2.480GHz.  Following the 802.15.4 standard, these frequencies are aliased as channel 11
through channel 24.  For all newly manufactured nodes, the default setting is equivalent to
2.425GHz (channel 15). 

For standard models, radiated transmit power is programmable from 0dBm (1mW) to 16dBm
(39mW). For Europeanmodels transmit power is limited to 10dBm (10mW).

The radio complies with ETSI EN 300 328, EN 300 440 Class 2, FCC CFR-47 Part 15 and
ARIB STD-T66.  The radio is license- free worldwide.  Using antennas and transmission
equipment other than what is provided with the nodemay void FCC compliance.

NOTE

l The gateway can automatically manage nodes operating on different
frequencies by using the Node Discovery feature in Node Commander®. In
this routine, the gateway listens for node broadcasts on the frequency
channel it is set to. If the node is in normal boot up mode, it will provide the
broadcast when it is initially powered on and broadcast on all channels. As
long as the node is powered on after activating the Node Discovery feature,
the gateway will link to it and remember the channel setting for future node
queries.

l Manually setting the node and gateway frequency channels to match is
required in some applications. For example, when sending broadcast
messages from the gateway to multiple nodes (including the synchronized
sampling beacon), all nodesmust be on the same channel as the gateway to
receive the broadcast. Assigning channels is also a good idea whenmultiple
gateways are attached to one host computer, or when other wireless
equipment is nearby and frequency or transmission interferencemay occur.
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12. Safety Information

This section provides a summary of general safety precautions that must be understood and
applied during operation and maintenance of components in the LORD MicroStrain® Wireless
Sensor Network.  Throughout the manual, ANSI Z535 standard safety symbols are used to
indicate a process or component that requires cautionarymeasures.

12.1 Battery Hazards

The SG-Link® -LXRS®Wireless Sensor Node contains an
internal, rechargeable Lithium Polymer (Li-Po) battery.  Li-
Po batteries are a fire and explosion hazard.  Do not store or
operate the node at temperatures above 212°F (100°C). Do
not disassemble, short circuit, crush, puncture, or otherwise
misuse the battery.

When recharging the node internal battery, use only the
power supply specified for node charging, and follow the
instructions. See Charging the Node Battery on page 64 .
Applying a voltage above the input range may result in
dangerous battery conditions or cause permanent damage
to the node.

Li-Po batteries contain toxic chemicals that are harmful to
humans and the environment.  Disposal is subject to federal
and local laws.  Do not discard the battery or the node in the
trash.  Follow proper battery disposal protocol, or contact
LORD MicroStrain® Technical Support for information on
extracting the battery or returning the product for proper
recycling and disposal.
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12.2 User Configurable Power Settings

The SG-Link® -LXRS®Wireless Sensor Node can be powered by either the internal battery, or
an external source. There is user-accessible switch to select the source. The default setting for
this switch is for internal battery operation and charging. See Selecting the Power Source on
page 62.

Connecting an external power source when the node is set to
internal power could result in injury or permanent node
damage.  For details on how to adjust the switch setting see
Connecting an External Power Supply on page 65.

l If the node is set to use an external source and the charging power supply is plugged
in, it will power the node from the power supply and not charge the battery.  It will
continue to use the internal battery.

l If the node is set to internal, and an external power supply other than the one used for
charging is plugged in, several things could happen.  If it is a power supply that is in
the operating range of the charging circuit, it may charge the battery.  If it is below the
range of the charging circuit, nothing will happen.  If the applied voltage is above the
range of the charging circuit, damage to the node will likely occur and personal injury
may result. 

l When under battery operation there is a limit to how much current the node can
provide to sensors.  If the node is in an over current condition it will shut off until the
cause is removed.  Using an external power source for the node or sensor can
mitigate this issue.
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13. References

13.1 Related Documents

Many references are available on the LORD MicroStrain® website including product user
manuals, technical notes, and quick start guides. These documents are continuously updated,
and new applications are added. They may provide more accurate information than printed or
file copies. 

Document Where to find it
Product Datasheets http://www.microstrain.com/wireless/sensors

Product Manuals and Technical Notes http://www.microstrain.com/support/docs
Product Application Notes http://www.microstrain.com/applications
NIST Calibration Procedures http://www.nist.gov/calibrations/

ASTM Testing Procedures
http://www.astm.org/Standard/standards-

and-publications.html

Table 10 - Related Documents

http://www.microstrain.com/wireless/sensors
http://www.microstrain.com/support/docs
http://www.microstrain.com/applications
http://www.nist.gov/calibrations/
http://www.astm.org/Standard/standards-and-publications.html
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13.2 Glossary

These terms are in common use throughout themanual:

A/D Value: the digital representation of the analog voltages in an analog to digital (A/D)
conversion. The accuracy of the conversion is dependent on the resolution of the system
electronics. Higher resolution produces amore accurate conversion.

ASTM: The Association of Standards and Testing is a nationally-accepted organization for the
testing and calibration of technological devices

Base Station: The base station is the transceiver that attaches to the host computer and
provides communication between the software and the node(s). It is also referred to as a
“gateway”.

Bits: the digital equivalent of voltage on the node

Calibration: to standardize a measurement by determining the deviation standard and
applying a correction, or calibration, factor

Configuration: a general term applied to the node indicating how it is set up for data
acquisition.  It includes settings such as sampling mode and rate, number of active channels,
channel measurement settings, offsets, hardware gain, and calibration values. 

Coordinated Universal Time (UTC): the primary time standard for world clocks and time. It
is similar to GreenwichMean Time (GMT)

Cycle Power: a command transmitted to the node to re-boot it, either through a hardware or
software switch

Data Acquisition: the process of collecting data from sensors and other devices

Data Logging: the process of saving acquired data to the system memory, either locally on
the node or remotely on the host computer

DHCP (network): Dynamic Host Configuration Protocol is the standardized networking
protocol used on Internet Protocol (IP) networks, which automatically configures devices that
are attached to it by assigning and configuring the device IP address.

Differential (signal): is a method of transmitting electrical signals in which they are paired
together as a differential pair and measured with reference to each other only.  This method
makes the pair less susceptible to electrical noise.
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EMI: Electromagnetic Interference is inductive or radiated disturbance that can create signal
degradation on electrical signals, including loss of data.

Firmware: the code that is programmed onto a microcontroller or similar device in an
embedded system that includes device operation commands, conditions, memory allocation
andmany other tasks 

Gateway: The gateway is a transceiver that attaches to the host computer and provides
communication between the software and the node(s). It is also known as a “base station”.

Host (computer): The host computer is the computer that orchestrates command and control
of attached devices or networks.

LED: Light Emitting Diode is an indicator light that is used in electronic equipment.

LOS: Line of Sight is used in radio communications to describe the ideal condition between
transmitting and receiving antennas in a radio network.  As stated, it means they are in view of
each other with no obstructions.

LXRS ® : Lossless Extended Range Synchronized is the LORD MicroStrain ® data
communications protocol used in the wireless sensor network.

NIST: TheNational Institute of Standards and Testing is a nationally-accepted organization for
testing and calibration of technological devices.

Node: The node is the wireless transceiver that the sensor (s) are connected to, providing
communication with the gateway.  The G-Link® -LXRS®, V-Link® -LXRS®, and SG-Link® -
LXRS® are all nodesmanufactured by LORD MicroStrain®.

Node Tester board: TheNode Tester board is a device designed by LORD MicroStrain® that
can be plugged into nodes to test functionality.

Offset: When describing amathematically-linear relationship, the offset is the value where the
line that represents the relationship in a graph crosses the y-axis.  The equation of a straight
line is: y = mx+b, where x is the x-axis coordinate, y is the y-axis coordinate,m is the slope and
b is the offset.

Ping: A byte is transmitted by the gateway to the node, and the node responds by echoing the
byte, indicating communication exists between them.

PGA: A Programmable Gain Amplifier is an electronic device used to amplify small electrical
signals.
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Range Test: a continuous string of pings used to validate communication between the
gateway and the node over distance and obstruction

Read/Write EEPROM: commands transmitted to the node to read or write parameters stored
in the node’s operating system

Real Time Clock (RTC): a computer clock that keeps track of the current time

Resolution: in digital systems, the resolution is the number of bits or values available to
represent analog values or information. For example, a 12-bit system has 4096 bits of
resolution and a 16-bit system has 65536 bits.

RFI: Radio Frequency Interference is a disturbance in an electrical circuit due to
electromagnetic induction or radiation.

RSSI: Received Signal Strength Indication is a measurement of the transmission power in a
radio signal. The units are decibels per meter (dBm).

RS232: a serial data communications protocol

Sensor: a device that physically or chemically reacts to environmental forces and conditions
and produces a predictable electrical signal as a result

Sleep: a command transmitted to the node to set a node into sleep configuration

Sampling: the process of takingmeasurements from a sensor or device

Sampling Mode: the type of sampling that is being utilized, such as event- triggered,
continuous, or periodic. The nodes have several samplingmodes that employ these types of
sampling.

Sampling Rate: the frequency of sampling

Single Ended: electrical signals that aremeasured with reference to a system ground

Slope:When describing amathematically linear relationship, the slope is the steepness of the
line that represents that relationship on a graph.  The equation of a straight line is: y = mx+b,
where x is the x-axis coordinate, y is the y-axis coordinate,m is the slope, and b is the offset.
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Streaming: Streaming is a sampling mode in which all active channels (and the sensors
attached to them) are measured, and the data acquired is transmitted to the gateway and
software. The data is not written to non- volatile memory during streaming.  Streaming can
either be finite (have a user defined start and end time) or continuous (continue until the power
is cycled on the node).

USB:Universal Serial Bus, a serial data communications protocol

Wheatstone Bridge: an electrical circuit used tomeasure unknown electrical resistances 

WSN: Wireless Sensor Network describes a distribution of sensors and data acquisition
equipment that autonomously monitors environmental characteristics, such as temperature,
pressure and strain.
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